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Configuring Layer 2 Interfaces

Note

Beginning with Cisco Release 5.2, the Cisco Nexus 7000 Series devices support FabricPath Layer 2
interfaces. See the Cisco Nexus 7000 Series NX-OS FabricPath Command Reference for complete
information about the FabricPath feature and interfaces.
This chapter describes how to configure Layer 2 switching ports as access or trunk ports on Cisco
NX-OS devices.using Cisco Data Center Network Manager (DCNM).

Note

The Cisco NX-OS release that is running on a managed device may not support all the features or settings
described in this chapter. For the latest feature information and caveats, see the documentation and
release notes for your platform and software release.
Layer 2 interfaces are used for switching packets. You can configure a Layer 2 port as an access port,
which carries only one VLAN, or a trunk port, which carries many VLANs. By default, a trunk port
carries all VLANs that are configured on the device, and you configure the trunk port to carry only those
VLANs that you want on that port. The device uses IEEE 802.1Q to tag packets. All trunk ports must be
in the same device, and trunk ports cannot carry VLANs from different devices.
You identify a native VLAN for each trunk port. The trunk port carries the traffic for that specific VLAN
as untagged packets. If you do not configure a native VLAN, the device uses the default VLAN to carry
untagged traffic for that trunk port. You can also configure the device to drop all untagged traffic on trunk
ports and to retain the tag for the native VLAN.

Note

Beginning with Cisco NX-OS Release 5.1, a Layer 2 port can function as either one of the following:
•

A trunk port

•

An access port

•

A private VLAN port (see the Cisco DCNM Layer 2 Switching Configuration Guide, Release 5.x,
for more information on private VLANs)

•

A FabricPath port (see the Cisco Nexus 7000 Series NX-OS FabricPath Configuration Guide,
Release 5.x, and the Cisco DCNM FabricPath Configuration Guide, Release 5.x, for information on
FabricPath)

Beginning with Cisco NX-OS Release 5.2(1), a Layer 2 port can also function as a shared interface. You
cannot configure an access interface as a shared interface. See the Cisco NX-OS FCoE Configuration
Guide for Cisco Nexus 7000 and Cisco MDS 9500 for information on shared interfaces.
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Note

See the Cisco DCNM FabricPath Configuration Guide, Release 5.x, for more information on configuring
the FabricPath feature.

Note

A Layer 2 port can function as either a trunk port, an access port, or a private VLAN port.
This chapter includes the following sections:

Note

•

Information About Access and Trunk Interfaces, page 3-111

•

Licensing Requirements for Layer 2 Port Modes, page 3-116

•

Prerequisites for Layer 2 Interfaces, page 3-116

•

Guidelines and Limitations, page 3-116

•

Default Settings, page 3-117

•

Platform Support, page 3-118

•

Configuring Access and Trunk Interfaces, page 3-118

•

Verifying the Interface Configuration, page 3-137

•

Monitoring the Layer 2 Interfaces, page 3-137

•

Example Configurations for Access and Trunk Ports, page 3-138

•

Field Descriptions, page 3-138

•

Additional References, page 3-139

•

Feature History for Configuring Layer 2 Interfaces, page 3-140

See the Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 5.x, for
information on configuring a SPAN destination interface.
For more information about the Data Center Network Manager features, see the Fundamentals
Configuration Guide, Cisco DCNM for LAN, Release 5.x .
You can configure Layer 2 switching ports as access or trunk ports. Trunks carry the traffic of multiple
VLANs over a single link and allow you to extend VLANs across an entire network. All Layer 2
switching ports maintain media access control (MAC) address tables.

Note

See the Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x, for
information on VLANs, MAC address tables, private VLANs, and the Spanning Tree Protocol.

Note

See the Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 6.x, for information on
VLANs, private VLANs, and the Spanning Tree Protocol.

Note

A Layer 2 port can function as either a trunk port, an access port, or a private VLAN port. See the Cisco
Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x, for more information on
private VLANs.
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Note

A Layer 2 port can function as either a trunk port, an access port, or a private VLAN port. See the Layer
2 Switching Configuration Guide, Cisco DCNM for LAN, Release 6.x, for more information on private
VLANs.

Information About Access and Trunk Interfaces
Note

See the Cisco Nexus 7000 Series NX-OS High Availability and Redundancy Guide, Release 5.x, for
complete information on high-availability features.
This section includes the following topics:

Note

•

Information About Access and Trunk Interfaces, page 3-111

•

IEEE 802.1Q Encapsulation, page 3-113

•

Access VLANs, page 3-113

•

Native VLAN IDs for Trunk Ports, page 3-114

•

Tagging Native VLAN Traffic, page 3-114

•

Allowed VLANs, page 3-114

•

High Availability, page 3-115

•

Virtualization Support, page 3-115

•

Default Interfaces, page 3-115

•

SVI Autostate Exclude, page 3-116

The device supports only IEEE 802.1Q-type VLAN trunk encapsulation.

Information About Access and Trunk Interfaces
A Layer 2 port can be configured as an access or a trunk port as follows:
•

An access port can have only one VLAN configured on that port; it can carry traffic for only one
VLAN.

•

A trunk port can have two or more VLANs configured on that port; it can carry traffic for several
VLANs simultaneously.

By default, all ports on the device are Layer 3 ports.
You change the default port setting to Layer 2 using the command-line interface (CLI). See the Layer 2
Switching Configuration Guide, Cisco DCNM for LAN, Release 6.x, for information on changing the
default port setting to Layer 2 for the system.
You can make all ports Layer 2 ports using the setup script or by entering the system default switchport
command. See the Cisco Nexus 7000 Series NX-OS Fundamentals Configuration Guide, Release 5.x, for
information on using the setup script. To configure the port as a Layer 2 port using the CLI, use the
switchport command,
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All ports in one trunk must be in the same virtual device context (VDC). See the Cisco Nexus 7000 Series
NX-OS Virtual Device Context Configuration Guide, Release 5.x, for information on VDCs.
All ports in the same trunk must be in the same VDC, and trunk ports cannot carry VLANs from different
VDCs.
All ports in the same trunk must be in the same device, and trunk ports cannot carry VLANs from
different devices.
Figure 3-1 shows how you can use trunk ports in the network. The trunk port carries traffic for two or
more VLANs.
Figure 3-1

Trunk and Access Ports and VLAN Traffic
C
Network

RADIUS
server

Syslog
server

C
Network

Syslog
server
SSH session to
manage-VDC

RADIUS
server

C3
Networ

RADIUS
server

Note

See the Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x, for
information on VLANs.

Note

See the Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 6.x, for information on
VLANs.
In order to correctly deliver the traffic on a trunk port with several VLANs, the device uses the IEEE
802.1Q encapsulation, or tagging, method (see the “IEEE 802.1Q Encapsulation” section on page 3-113
for more information).

Note

See the Cisco Nexus 7000 Series NX-OS Unicast Routing Configuration Guide, Release 5.x, for
information on subinterfaces on Layer 3 interfaces.

Note

See the Unicast Configuration Guide, Cisco DCNM for LAN, Release 6.x, for information on
subinterfaces on Layer 3 interfaces.
To optimize the performance on access ports, you can configure the port as a host port. Once the port is
configured as a host port, it is automatically set as an access port, and channel grouping is disabled. Use
the host designation to decrease the time that it takes the designated port to begin to forward packets.
Only an end station can be set as a host port; you will receive an error message if you attempt to configure
other ports as hosts.
If an access port receives a packet with an 802.1Q tag in the header other than the access VLAN value,
that port drops the packet without learning its MAC source address.
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A Layer 2 interface can function as either an access port or a trunk port; it cannot function as both port
types simultaneously.
When you change a Layer 2 interface back to a Layer 3 interface, that interface loses all the Layer 2
configuration and resumes the default VLAN configurations.

IEEE 802.1Q Encapsulation
Note

For information about VLANs, see the Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration
Guide, Release 5.x.

Note

For information about VLANs, see the Layer 2 Switching Configuration Guide, Cisco DCNM for LAN,
Release 6.x.
A trunk is a point-to-point link between the switch and another networking device. Trunks carry the
traffic of multiple VLANs over a single link and allow you to extend VLANs across an entire network.
To correctly deliver the traffic on a trunk port with several VLANs, the device uses the IEEE 802.1Q
encapsulation, or tagging, method that uses a tag that is inserted into the frame header (see Figure 3-1).
This tag carries information about the specific VLAN to which the frame and packet belong. This
method allows packets that are encapsulated for several different VLANs to traverse the same port and
maintain traffic separation between the VLANs. Also, the encapsulated VLAN tag allows the trunk to
move traffic end-to-end through the network on the same VLAN.

Access VLANs
Note

If you assign an access VLAN that is also a primary VLAN for a private VLAN, all access ports with
that access VLAN will also receive all the broadcast traffic for the primary VLAN in the private VLAN
mode.

Note

See the Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x, for
complete information on private VLANs.

Note

See the Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 6.x, for complete
information on private VLANs.
When you configure a port in access mode, you can specify which VLAN will carry the traffic for that
interface. If you do not configure the VLAN for a port in access mode, or an access port, the interface
carries traffic for the default VLAN (VLAN1).
You can change the access port membership in a VLAN by specifying the new VLAN. You must create
the VLAN before you can assign it as an access VLAN for an access port. If you change the access
VLAN on an access port to a VLAN that is not yet created, the system shuts that access port down.
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If an access port receives a packet with an 802.1Q tag in the header other than the access VLAN value,
that port drops the packet without learning its MAC source address.

Native VLAN IDs for Trunk Ports
A trunk port can carry nontagged packets simultaneously with the 802.1Q tagged packets. When you
assign a default port VLAN ID to the trunk port, all untagged traffic travels on the default port VLAN
ID for the trunk port, and all untagged traffic is assumed to belong to this VLAN. This VLAN is referred
to as the native VLAN ID for a trunk port. That is, the native VLAN ID is the VLAN that carries
untagged traffic on trunk ports.

Note

Native VLAN ID numbers must match on both ends of the trunk.
The trunk port sends an egressing packet with a VLAN that is equal to the default port VLAN ID as
untagged; all the other egressing packets are tagged by the trunk port. If you do not configure a native
VLAN ID, the trunk port uses the default VLAN.

Note

You cannot use an FCoE VLAN as a native VLAN for an Ethernet trunk switchport.

Tagging Native VLAN Traffic
The Cisco software supports the IEEE 802.1Q standard on trunk ports. In order to pass untagged traffic
through the trunk ports, you must create a VLAN that does not tag any packets (or you can use the default
VLAN). Untagged packets can pass through trunk ports and access ports.
However, all packets that enter the device with an 802.1Q tag that matches the value of the native VLAN
on the trunk are stripped of any tagging and egress the trunk port as untagged packets. This situation can
cause problems because you may want to retain the tagging on packets on the native VLAN for the trunk
port.
You can configure the device to drop all untagged packets on the trunk ports and to retain the tagging of
packets entering the device with 802.1Q values that are equal to that of the native VLAN ID. All control
traffic still passes on the native VLAN. This configuration is global; trunk ports on the device either do
or do not retain the tagging for the native VLAN.

Allowed VLANs
By default, a trunk port sends traffic to and receives traffic from all VLANs. All VLAN IDs are allowed
on each trunk. However, you can remove VLANs from this inclusive list to prevent traffic from the
specified VLANs from passing over the trunk. Later, you can add any specific VLANs that you may want
the trunk to carry traffic for back to the list.
To partition the Spanning Tree Protocol (STP) topology for the default VLAN, you can remove VLAN1
from the list of allowed VLANs. Otherwise, VLAN1, which is enabled on all ports by default, will have
a very big STP topology, which can result in problems during STP convergence. When you remove
VLAN1, all data traffic for VLAN1 on this port is blocked, but the control traffic continues to move on
the port.
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Note

See the Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x, for more
information about STP.

Note

Beginning with Cisco Release 5.2, you can change the block of VLANs reserved for internal use. See
the Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x, for more
information about changing the reserved VLANs.

Note

See the Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 6.x, for more
information about STP.

High Availability
The software supports high availability for Layer 2 ports.

Note

See the Cisco Nexus 7000 Series NX-OS High Availability and Redundancy Guide, Release 5.x, for
complete information on high availability features.

Virtualization Support
The device supports virtual device contexts (VDCs).
All ports in the same trunk must be in the same VDC, and trunk ports cannot carry VLANs from different
VDCs.
All ports in the same trunk must be in the same device, and trunk ports cannot carry VLANs from
different devices.

Note

See the Cisco Nexus 7000 Series NX-OS Virtual Device Context Configuration Guide, Release 5.x, for
complete information on VDCs and assigning resources.

Note

See the Virtual Device Context Configuration Guide, Cisco DCNM for LAN, Release 6.x, for complete
information on VDCs and assigning resources.

Default Interfaces
You can use the default interface feature to clear the configured parameters for both physical and logical
interfaces such as the Ethernet, loopback, VLAN network, tunnel, and the port-channel interface.

Note

A maximum of 8 ports can be selected for the default interface. The default interfaces feature is not
supported for management interfaces because the device could go to an unreachable state.
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SVI Autostate Exclude
Ordinarily, when a VLAN interface has multiple ports in the VLAN, the SVI will go to the down state
when all the ports in the VLAN go down. You can use the SVI Autostate Exclude feature to exclude
specific ports and port channels while defining the status of the SVI (up or down) even if it belongs to
the same VLAN. For example, even if the excluded port or port channel is in the up state and other ports
are in the down state in the VLAN, the SVI state is changed to down.

Note

You can use the SVI Autostate Exclude feature only for switched physical Ethernet ports and port
channels.

Licensing Requirements for Layer 2 Port Modes
The following table shows the licensing requirements for this feature:
Product

License Requirement

Cisco DCNM

Layer 2 port modes require no license. Any feature not included in a license package is bundled with the
Cisco DCNM and is provided at no charge to you.

Cisco NX-OS

Layer 2 port modes require no license. Any feature not included in a license package is bundled with the
Cisco NX-OS system images and is provided at no extra charge to you. For a complete explanation of the
Cisco NX-OS licensing scheme, see the Cisco NX-OS Licensing Guide.

Note

Using VDCs requires an Advanced Services license.

Prerequisites for Layer 2 Interfaces
Layer 2 interfaces have the following prerequisites:
•

You are logged onto the device.

•

You must configure the port as a Layer 2 port before you can use the switchport mode command.
By default, all ports on the NX-OS are Layer 3 ports.

Guidelines and Limitations
VLAN trunking has the following configuration guidelines and limitations:
•

A port can be either a Layer 2 or a Layer 3 interface; it cannot be both simultaneously.

•

When you change a Layer 3 port to a Layer 2 port or a Layer 2 port to a Layer 3 port, all
layer-dependent configuration is lost. When you change an access or trunk port to a Layer 3 port,
all information about the access VLAN, native VLAN, allowed VLANs, and so forth, is lost.

•

Do not connect devices with access links because access links may partition a VLAN.

Cisco Prime DCNM Interfaces Configuration Guide, Release 7.x

3-116

OL-30761-01

Chapter 3

Configuring Layer 2 Interfaces
Default Settings

•

When connecting Cisco devices through an 802.1Q trunk, make sure that the native VLAN for an
802.1Q trunk is the same on both ends of the trunk link. If the native VLAN on one end of the trunk
is different from the native VLAN on the other end, spanning tree loops might result.

•

Disabling spanning tree on the native VLAN of an 802.1Q trunk without disabling spanning tree on
every VLAN in the network can cause spanning tree loops. You must leave spanning tree enabled
on the native VLAN of an 802.1Q trunk. If you cannot leave spanning tree enabled, you must disable
spanning tree on every VLAN in the network. Make sure that your network has no physical loops
before you disable spanning tree.

•

When you connect two Cisco devices through 802.1Q trunks, the devices exchange spanning tree
bridge protocol data units (BPDUs) on each VLAN allowed on the trunks. The BPDUs on the native
VLAN of the trunk are sent untagged to the reserved IEEE 802.1D spanning tree multicast MAC
address (01-80-C2-00-00-00). The BPDUs on all other VLANs on the trunk are sent tagged to the
reserved Cisco Shared Spanning Tree (SSTP) multicast MAC address (01-00-0c-cc-cc-cd).

•

Non-Cisco 802.1Q devices maintain only a single instance of spanning tree (the Mono Spanning
Tree) that defines the spanning tree topology for all VLANs. When you connect a Cisco switch to a
non-Cisco switch through an 802.1Q trunk, the Mono Spanning Tree of the non-Cisco switch and
the native VLAN spanning tree of the Cisco switch combine to form a single spanning tree topology
known as the Common Spanning Tree (CST).

•

Because Cisco devices transmit BPDUs to the SSTP multicast MAC address on VLANs other than
the native VLAN of the trunk, non-Cisco devices do not recognize these frames as BPDUs and flood
them on all ports in the corresponding VLAN. Other Cisco devices connected to the non-Cisco
802.1Q cloud receive these flooded BPDUs. This BPDU reception allows Cisco switches to
maintain a per-VLAN spanning tree topology across a cloud of non-Cisco 802.1Q devices. The
non-Cisco 802.1Q cloud that separates the Cisco devices is treated as a single broadcast segment
between all devices connected to the non-Cisco 802.1Q cloud through 802.1Q trunks.

•

Make certain that the native VLAN is the same on all of the 802.1Q trunks that connect the Cisco
devices to the non-Cisco 802.1Q cloud.

•

If you are connecting multiple Cisco devices to a non-Cisco 802.1Q cloud, all of the connections
must be through 802.1Q trunks. You cannot connect Cisco devices to a non-Cisco 802.1Q cloud
through access ports because doing so places the access port on the Cisco device into the spanning
tree “port inconsistent” state and no traffic will pass through the port.

•

You can group trunk ports into port-channel groups, but all trunks in the group must have the same
configuration. When a group is first created, all ports follow the parameters set for the first port to
be added to the group. If you change the configuration of one of these parameters, the device
propagates that setting to all ports in the group, such as the allowed VLANs and the trunk status. For
example, if one port in a port group ceases to be a trunk, all ports cease to be trunks.

•

If you try to enable 802.1X on a trunk port, an error message appears, and 802.1X is not enabled. If
you try to change the mode of an 802.1X-enabled port to trunk, the port mode is not changed.

Default Settings
Table 3-1 lists the default settings for device access and trunk port mode parameters.
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Table 3-1

Default Access and Trunk Port Mode Parameters

Parameters

Default

Switchport mode

Access

Allowed VLANs

1 to 3967, 4048 to 4094

Access VLAN ID

VLAN1

Native VLAN ID

VLAN1

Native VLAN ID tagging

Disabled

Administrative state

Shut

Platform Support
The following platforms support this feature but may implement it differently. For platform-specific
information, including guidelines and limitations, system defaults, and configuration limits, see the
corresponding documentation.
Platform

Documentation

Cisco Nexus 1000V Series Switches

Cisco Nexus 1000V Series Switches Documentation

Cisco Nexus 3000 Series Switches

Cisco Nexus 3000 Series Switches Documentation

Cisco Nexus 4000 Series Switches

Cisco Nexus 4000 Series Switches Documentation

Cisco Nexus 5000 Series Switches

Cisco Nexus 5000 Series Switches Documentation

Cisco Nexus 7000 Series Switches

Cisco Nexus 7000 Series Switches Documentation

Cisco Catalyst 6500 Series Switches

Cisco Catalyst 6500 Series Switches Documentation

Configuring Access and Trunk Interfaces
Note

Beginning with Cisco NX-OS Release 5.1, you can configure Layer 2 interfaces as Fabricpath interfaces
if you have an F Series module in your Cisco Nexus 7000 Series chassis. See the Cisco DCNM
FabricPath Configuration Guide and the Cisco Nexus 7000 Series NX-OS FabricPath Configuration
Guide for more information on configuring FabricPath.
This section includes the following topics:
•

Guidelines for Configuring Access and Trunk Interfaces, page 3-119

•

Configuring a LAN Interface as a Layer 2 Access Port, page 3-119

•

Configuring Access Host Ports, page 3-122

•

Configuring Trunk Ports, page 3-123

•

Configuring the Native VLAN for 802.1Q Trunking Ports, page 3-124

•

Configuring the Allowed VLANs for Trunking Ports, page 3-126

•

Configuring the Native VLAN for 802.1Q Trunking Ports, page 3-124

•

Configuring a Default Interface, page 3-128
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Note

•

Configuring SVI Autostate Exclude, page 3-130

•

Configuring the Device to Tag Native VLAN Traffic, page 3-134

•

Changing the System Default Port Mode to Layer 2, page 3-136

If you are familiar with the Cisco IOS CLI, be aware that the Cisco NX-OS commands for this feature
might differ from the Cisco IOS commands that you would use.

Guidelines for Configuring Access and Trunk Interfaces
All VLANs on a trunk must be in the same VDC.

Configuring a LAN Interface as a Layer 2 Access Port
You can configure a Layer 2 port as an access port. An access port transmits packets on only one,
untagged VLAN. You specify which VLAN traffic that the interface carries, which becomes the access
VLAN. If you do not specify a VLAN for an access port, that interface carries traffic only on the default
VLAN. The default VLAN is VLAN1.
The VLAN must exist before you can specify that VLAN as an access VLAN. The system shuts down
an access port that is assigned to an access VLAN that does not exist.

BEFORE YOU BEGIN
Ensure that you are configuring a Layer 2 interface.

SUMMARY STEPS
1.

configure terminal

2.

interface {{type slot/port} | {port-channel number}}

3.

switchport mode {access | trunk}

4.

switchport access vlan vlan-id

5.

exit

6.

(Optional) show interface

7.

(Optional) copy running-config startup-config
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You use the Ethernet pane to configure a Layer 2 access port (see Figure 3-2).
Figure 3-2

Ethernet Pane, Port Mode Settings

DETAILED STEPS
Step 1

From the Feature Selector pane, choose Interfaces > Physical > Ethernet to open the Ethernet pane.

Step 2

From the Contents pane, in the Summary pane, double-click the device to display the interfaces.

Step 3

Click the slot to display the list of interfaces.

Step 4

Click the interface.
The system highlights the interface in the Summary pane, and tabs appear in the Details pane.

Step 5

In the Details pane, click the Port Details tab.

Step 6

Click the Port Mode Settings section.

Step 7

From the Mode drop-down list, choose Access to configure the port as an access port.
Routed is the default port mode.

Step 8

In the Access VLAN field, specify the access VLAN by using a known VLAN, assigning a VLAN from
among the VLANs on this device, or creating a new VLAN.
The default access VLAN is VLAN1. The range is VLAN 1 to 4094, excluding the internally assigned
VLANs 3968 to 4047 and 4094.

Step 9

From the menu bar, choose File > Deploy to apply your changes to the device.
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Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

Specifies an interface to configure, and enters interface
configuration mode.

interface {{type slot/port} |
{port-channel number}}
Example:
switch(config)# interface ethernet 3/1
switch(config-if)#

Step 3

Sets the interface as a nontrunking nontagged,
single-VLAN Layer 2 interface. An access port can
carry traffic in one VLAN only. By default, an access
port carries traffic for VLAN1; to set the access port to
carry traffic for a different VLAN, use the switchport
access vlan command.

switchport mode {access | trunk}
Example:
switch(config-if)# switchport mode
access

Step 4

switchport access vlan vlan-id
Example:
switch(config-if)# switchport access
vlan 5

Step 5

Specifies the VLAN for which this access port will
carry traffic. If you do not enter this command, the
access port carries traffic on VLAN1 only; use this
command to change the VLAN for which the access
port carries traffic.
Exits the configuration mode.

exit
Example:
switch(config-if)# exit
switch(config)#

Step 6

(Optional) Displays the interface status and
information.

show interface
Example:
switch# show interface

Step 7

copy running-config startup-config
Example:
switch(config)# copy running-config
startup-config

(Optional) Copies the running configuration to the
startup configuration.

This example shows how to set Ethernet 3/1 as a Layer 2 access port that carries traffic for VLAN 5 only:
switch# configure terminal
switch(config)# interface ethernet 3/1
switch(config-if)# switchport mode access
switch(config-if)# switchport access vlan 5
switch(config-if)#

RELATED TOPICS
•

Configuring the Native VLAN for 802.1Q Trunking Ports

•

Configuring the Device to Tag Native VLAN Traffic
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Configuring Access Host Ports
Note

You should apply the switchport host command only to interfaces connected to an end station.
You can optimize the performance of access ports that are connected to end stations by simultaneously
setting that port as an access port. An access host port handles the STP like an edge port and immediately
moves to the forwarding state without passing through the blocking and learning states. Configuring an
interface as an access host port also disables port channeling on that interface.

Note

See Chapter 5, “Configuring Port Channels” for information on port-channel interfaces and the Cisco
Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x. For complete
information on the Spanning Tree Protocol.

BEFORE YOU BEGIN
Ensure that you are configuring the correct interface to an interface that is an end station.

SUMMARY STEPS
1.

configure terminal

2.

interface type slot/port

3.

switchport host

4.

exit

5.

(Optional) show interface

6.

(Optional) copy running-config startup-config

DETAILED STEPS

Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

interface type slot/port
Example:
switch(config)# interface ethernet 3/1
switch(config-if)#

Step 3

switchport host

Example:
switch(config-if)# switchport host

Specifies an interface to configure, and enters interface
configuration mode.

Sets the interface to be an access host port, which
immediately moves to the spanning tree forwarding
state and disables port channeling on this interface.
Note

Apply this command only to end stations.

Cisco Prime DCNM Interfaces Configuration Guide, Release 7.x

3-122

OL-30761-01

Chapter 3

Configuring Layer 2 Interfaces
Configuring Access and Trunk Interfaces

Step 4

Command

Purpose

exit

Exits the interface mode.

Example:
switch(config-if)# exit
switch(config)#

Step 5

(Optional) Displays the interface status and
information.

show interface
Example:
switch# show interface

Step 6

copy running-config startup-config
Example:
switch(config)# copy running-config
startup-config

(Optional) Copies the running configuration to the
startup configuration.

This example shows how to set Ethernet 3/1 as a Layer 2 access port with PortFast enabled and port
channel disabled:
switch# configure terminal
switch(config)# interface ethernet 3/1
switch(config-if)# switchport host
switch(config-if)#

Configuring Trunk Ports
You can configure a Layer 2 port as a trunk port. A trunk port transmits untagged packets for one VLAN
plus encapsulated, tagged, packets for multiple VLANs. (See the “IEEE 802.1Q Encapsulation” section
on page 3-113 for information about encapsulation.)

Note

The device supports 802.1Q encapsulation only.

BEFORE YOU BEGIN
Before you configure a trunk port, ensure that you are configuring a Layer 2 interface.

SUMMARY STEPS
1.

configure terminal

2.

interface {type slot/port | port-channel number}

3.

switchport mode {access | trunk}

4.

exit

5.

(Optional) show interface

6.

(Optional) copy running-config startup-config
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DETAILED STEPS

Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

interface {type slot/port | port-channel
number}

Specifies an interface to configure, and enters interface
configuration mode.

Example:
switch(config)# interface ethernet 3/1
switch(config-if)#

Step 3

switchport mode {access | trunk}

Step 4

exit

Sets the interface as a Layer 2 trunk port. A trunk port
can carry traffic in one or more VLANs on the same
physical link (VLANs are based on the trunk-allowed
Example:
switch(config-if)# switchport mode trunk VLANs list). By default, a trunk interface can carry
traffic for all VLANs. To specify that only certain
VLANs are allowed on the specified trunk, use the
switchport trunk allowed vlan command.
Exits the interface mode.

Example:
switch(config-if)# exit
switch(config)#

Step 5

show interface
Example:
switch# show interface

Step 6

copy running-config startup-config
Example:
switch(config)# copy running-config
startup-config

(Optional) Displays the interface status and
information.
(Optional Copies the running configuration to the
startup configuration.

This example shows how to set Ethernet 3/1 as a Layer 2 trunk port:
switch# configure terminal
switch(config)# interface ethernet 3/1
switch(config-if)# switchport mode trunk
switch(config-if)#

Configuring the Native VLAN for 802.1Q Trunking Ports
You can configure the native VLAN for 802.1Q trunk ports. If you do not configure this parameter, the
trunk port uses the default VLAN as the native VLAN ID.

Note

You cannot configure an FCoE VLAN as a native VLAN for an Ethernet interface.
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SUMMARY STEPS
1.

configure terminal

2.

interface {type slot/port | port-channel number}

3.

switchport trunk native vlan vlan-id

4.

exit

5.

(Optional) show vlan

6.

(Optional) copy running-config startup-config

DETAILED STEPS

Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

interface {type slot/port | port-channel
number}

Specifies an interface to configure, and enters interface
configuration mode.

Example:
switch(config)# interface ethernet 3/1
switch(config-if)#

Step 3

switchport trunk native vlan vlan-id
Example:
switch(config-if)# switchport trunk
native vlan 5

Step 4

Sets the native VLAN for the 802.1Q trunk. Valid
values are from 1 to 4094, except those VLANs
reserved for internal use. The default value is VLAN1.
Exits the interface mode.

exit
Example:
switch(config-if)# exit
switch(config)#

Step 5

(Optional) Displays the status and information of
VLANs.

show vlan
Example:
switch# show vlan

Step 6

copy running-config startup-config
Example:
switch(config)# copy running-config
startup-config

(Optional) Copies the running configuration to the
startup configuration.

This example shows how to set the native VLAN for the Ethernet 3/1, Layer 2 trunk port to VLAN 5:
switch# configure terminal
switch(config)# interface ethernet 3/1
switch(config-if)# switchport trunk native vlan 5
switch(config-if)#
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Configuring the Allowed VLANs for Trunking Ports
You can specify the IDs for the VLANs that are allowed on the specific trunk port.

Note

The switchport trunk allowed vlan vlan-list command replaces the current VLAN list on the specified
port with the new list. Consequently you are prompted for confirmation before the new list is applied.
As a side effect, if you are doing copy and paste of a large configuration then you may see some failures
as the CLI is waiting for a confirmation before accepting other commands. To avoid this you can disable
prompting using the terminal dont-ask command before you paste the configuration.

BEFORE YOU BEGIN
Before you configure the allowed VLANs for the specified trunk ports, ensure that you are configuring
the correct interfaces and that the interfaces are trunks.

Note

Beginning with Cisco Release 5.2, you can change the block of VLANs reserved for internal use. See
the Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x, for more
information about changing the reserved VLANs.

SUMMARY STEPS
1.

configure terminal

2.

interface {ethernet slot/port | port-channel number}

3.

switchport trunk allowed vlan {vlan-list | add vlan-list | all | except vlan-list | none | remove
vlan-list}

4.

exit

5.

(Optional) show vlan

6.

(Optional) copy running-config startup-config

DETAILED STEPS

Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

interface {ethernet slot/port |
port-channel number}

Specifies an interface to configure, and enters interface
configuration mode.

Example:
switch(config)# interface ethernet 3/1
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Step 3

Command

Purpose

switchport trunk allowed vlan {vlan-list
add vlan-list | all |except vlan-list |
none | remove vlan-list}

Sets the allowed VLANs for the trunk interface. The
default is to allow all VLANs on the trunk interface: 1
to 3967 and 4048 to 4094. VLANs 3968 to 4047 are the
default VLANs reserved for internal use by default. By
default, all VLANs are allowed on all trunk interfaces.
Beginning with Cisco Release 5.2(1), the default
reserved VLANs are 3968 to 4094, and you can change
the block of reserved VLANs. See the Cisco Nexus
7000 Series NX-OS Layer 2 Switching Configuration
Guide, Release 5.x, for more information.

Example:
switch(config-if)# switchport trunk
allowed vlan add 15-20#

Note

Step 4

You cannot add internally allocated VLANs as
allowed VLANs on trunk ports. The system
returns a message if you attempt to list an
internally allocated VLAN as an allowed
VLAN.

Exits the interface mode.

exit
Example:
switch(config-if)# exit
switch(config)#

Step 5

(Optional) Displays the status and information for
VLANs.

show vlan
Example:
switch# show vlan

Step 6

copy running-config startup-config
Example:
switch(config)# copy running-config
startup-config

(Optional) Copies the running configuration to the
startup configuration.

This example shows how to add VLANs 15 to 20 to the list of allowed VLANs on the Ethernet 3/1, Layer
2 trunk port:
switch# configure terminal
switch(config)# interface ethernet 3/1
switch(config-if)# switchport trunk allowed vlan 15-20
switch(config-if)#

Configuring a Trunk Port and a FabricPath Port
Note

You can pre-provision a trunk port while the actual port is still in access mode. From the main menu,
choose Tools > Global Preferences > Pre Provisioning to access or hide the screen that allows and
displays this functionality. See the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release
5.x , for information on pre-provisioning.
You can configure a Layer 2 port as a trunk port, which transmits untagged packets for one VLAN plus
transmits encapsulated, tagged, packets for multiple VLANs.
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Note

The device supports 802.1Q encapsulation only.
You use the Ethernet pane to configure a Layer 2 trunk port (see Figure 3-2).

DETAILED STEPS
Step 1

From the Feature Selector pane, choose Interfaces > Physical > Ethernet to open the Ethernet pane.

Step 2

From the Contents pane, in the Summary pane, double-click the device to display the interfaces.

Step 3

Click the slot to display the list of interfaces.

Step 4

Click the interface.
The system highlights the interface in the Summary pane, and tabs appear in the Details pane.

Step 5

In the Details pane, click the Port Details tab.

Step 6

Click the Port Mode Settings section.

Step 7

From the Mode drop-down list, choose Trunk to configure the port as a trunk port.

Note

Step 8

Do not change the dimmed value in the Encapsulation row from dot1q. The IEEE 802.1Q
encapsulation method is the only supported encapsulation method.

In the Allowed VLAN field, enter the numbers of the VLANs or select the VLANs that are allowed to
run on this trunk port.
VLANs 1 to 4094 are the default. VLANs 3968 to 4047 and 4094 are internally allocated for device use.

Step 9

In the Native VLAN field, specify, choose, or create the native VLAN for this trunk port.
The default native VLAN is VLAN1. The range is from VLAN 1 to 4094, excluding the internally
assigned VLANs 3968 to 4047 and 4094.

Step 10

From the Mode drop-down list, choose Fabricpath to configure the port as a FabricPath port.

Step 11

From the menu bar, choose File > Deploy to apply your changes to the device.

Configuring a Default Interface
The default interface feature allows you to clear the existing configuration of multiple interfaces such as
Ethernet, loopback, VLAN network, port-channel, and tunnel interfaces. All user configuration under a
specified interface will be deleted. You can optionally create a checkpoint before clearing the interface
configuration so that you can later restore the deleted configuration.

Note

The default interface feature is not supported for management interfaces because the device could go to
an unreachable state.
You can select a maximum of 8 ports for a default interface configuration. If you select more than 8 ports
and click Set to Default, a dialog box appears (see Figure 3-2).
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Figure 3-3

Default Interfaces Dialog Box

DETAILED STEPS
Step 1

From the Feature Selector pane, choose Interfaces > Logical> Tunnel or VLAN Network Interface or
Loopback or Port-Channel.

Step 2

From the Contents pane, in the Summary pane, double click the device to display the interfaces.

Step 3

Right-click and choose Set to Default.

SUMMARY STEPS
1.

configure terminal

2.

default interface int-if [checkpoint name]

3.

exit

4.

(Optional) show interface
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DETAILED STEPS

Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

default interface int-if [checkpoint
name]
Example:
switch(config)# default interface
ethernet 3/1 checkpoint test8

Step 3

exit

Deletes the configuration of the interface and restores
the default configuration. Use the ? keyword to display
the supported interfaces.
Use the checkpoint keyword to store a copy of the
running configuration of the interface before clearing
the configuration.
Exits the configuration mode.

Example:
switch(config)# exit
switch#

Step 4

show interface
Example:
switch# show interface

(Optional) Displays the interface status and
information.

This example shows how to delete the configuration of an Ethernet interface while saving a checkpoint
of the running configuration for rollback purposes:
switch# configure terminal
switch(config)# default interface ethernet 3/1 checkpoint test8
.......Done
switch(config)#

Configuring SVI Autostate Exclude
You can configure the SVI Autostate Exclude feature on an Ethernet interface or a port channel.
You can use the Autostate Exclude option to enable or disable the port from bringing up or down the SVI
calculation and applying it to all VLANs that are enabled on the selected port. (see Figure 3-4).
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Figure 3-4

Ethernet Interface

DETAILED STEPS
Step 1

From the Feature Selector pane, choose Interfaces > Physical > Ethernet to open the Ethernet pane.

Step 2

From the Summary pane, double-click the device to display the interfaces.

Step 3

Click the slot to display the list of interfaces.

Step 4

Click the interface.
The system highlights the interface in the Summary pane, and tabs appear in the Details pane.

Step 5

In the Details pane, click the Port Details tab.

Step 6

Expand the Port Mode Settings section.

Step 7

From the Autostate exclude drop-down list, choose Enabled or Disabled to bring up or down the SVI
calculation and apply it to all VLANs that are enabled on the selected port.

You can configure SVI Autostate Exclude on a port channel (see Figure 3-5).
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Figure 3-5

SVI Port Channel

DETAILED STEPS
Step 1

From the Feature Selector pane, choose Interfaces > Logical > Port Channel to open the Port Channel
pane.

Step 2

From the Summary pane, double-click the device to display the interfaces.

Step 3

Click the slot to display the list of interfaces.

Step 4

Click the interface.
The system highlights the interface in the Summary pane, and tabs appear in the Details pane.

Step 5

From the Port Channel Details tab, expand the Common Settings section.

Step 6

From the Autostate exclude drop-down list, choose Enabled or Disabled to bring up or down the SVI
calculation and apply it to all VLANs that are enabled on the selected port.

SUMMARY STEPS
1.

configure terminal

2.

interface {{type slot/port} | {port-channel number}}

3.

switchport

4.

switchport autostate exclude

5.

exit
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6.

(Optional) show running-config interface

7.

(Optional) copy running-config startup-config

DETAILED STEPS

Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

Specifies an interface to configure, and enters interface
configuration mode.

interface {{type slot/port} |
{port-channel number}}
Example:
switch(config)# interface ethernet 3/1
switch(config-if)#

Step 3

Sets the interface as a Layer 2 interface.

switchport
Example:
switch(config-if)# switchport

Step 4

Step 5

switchport autostate exclude

Excludes this port from the VLAN interface link-up
calculation when there are multiple ports in the VLAN.

Example:
switch(config-if)# switchport autostate
exclude

To revert to the default settings, use the no form of this
command.

exit

Exits the configuration mode.

Example:
switch(config-if)# exit
switch(config)#

Step 6

show running-config interface {{type
slot/port} | {port-channel number}}

(Optional) Displays configuration information about
the specified interface.

Example:
switch(config)# show running-config
interface ethernet 3/1

Step 7

copy running-config startup-config
Example:
switch(config)# copy running-config
startup-config

(Optional) Copies the running configuration to the
startup configuration.

This example shows how to exclude a port from the VLAN interface link-up calculation on the Cisco
NX-OS device:
switch# configure terminal
switch(config)# interface ethernet 3/1
switch(config-if)# switchport
switch(config-if)# switchport autostate exclude

RELATED TOPICS
•

Configuring a LAN Interface as a Layer 2 Access Port

•

Configuring the Device to Tag Native VLAN Traffic
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Configuring the Device to Tag Native VLAN Traffic
When you are working with 802.1Q trunked interfaces, you can maintain the tagging for all packets that
enter with a tag that matches the value of the native VLAN ID and drops all untagged traffic (you will
still carry control traffic on that interface). This feature applies to the entire device; you cannot apply it
to selected VLANs on a device.
The vlan dot1q tag native global command changes the behavior of all native VLAN ID interfaces on
all trunks on the device.

Note

If you enable 802.1Q tagging on one device and disable it on another device, all traffic is dropped on the
device with this feature disabled. You must configure this feature identically on each device.

BEFORE YOU BEGIN
Ensure that you are in the correct VDC (or use the switchto vdc command). You can repeat VLAN
names and IDs in different VDCs, so you must confirm that you are working in the correct VDC.

SUMMARY STEPS
1.

configure terminal

2.

vlan dot1q tag native

3.

exit

4.

(Optional) show vlan

5.

(Optional) copy running-config startup-config

You use the VLAN pane to configure the device to maintain the tagging for all native VLANs for all
trunking ports (see Figure 3-6).
Figure 3-6

VLAN Pane, Global Settings
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DETAILED STEPS
Step 1

From the Feature Selector pane, choose Switching > VLAN to open the VLAN pane.

Step 2

In the Summary pane, click the Device View tab.

Step 3

Click the device that you want to configure.
The system highlights the device in the Summary pane, and tabs appear in the Details pane.

Step 4

In the Details pane, click the Global Settings tab.

Step 5

From the Dot1Q Native Tag drop-down list, choose Enabled to configure the device to maintain the
802.1q tag on the native VLAN for all trunking ports.
The default is disabled.

Step 6

Step 1

From the menu bar, choose File > Deploy to apply your changes to the device.

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

vlan dot1q tag native

Example:
switch(config)# vlan dot1q tag native

Step 3

Modifies the behavior of a 802.1Q trunked native
VLAN ID interface. The interface maintains the
taggings for all packets that enter with a tag that
matches the value of the native VLAN ID and drops all
untagged traffic. The control traffic is still carried on
the native VLAN. The default is disabled.
Exits the configuration mode.

exit
Example:
switch(config)# exit
switch#

Step 4

(Optional) Displays the status and information for
VLANs.

show vlan
Example:
switch# show vlan

Step 5

(Optional) Copies the running configuration to the
startup configuration.

copy running-config startup-config
Example:
switch# copy running-config
startup-config

This example shows how to change the behavior of the native VLAN on an 802.1Q trunked interface to
maintain the tagged packets and drop all untagged traffic (except control traffic):
switch# configure terminal
switch(config)# vlan dot1q tag native
switch#
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RELATED TOPICS
•

Configuring a LAN Interface as a Layer 2 Access Port

•

Configuring the Native VLAN for 802.1Q Trunking Ports

Changing the System Default Port Mode to Layer 2
You can set the system default port mode to Layer 2 access ports.
See the Cisco NX-OS FCoE Configuration Guide for Cisco Nexus 7000 and Cisco MDS 9500 for
information on setting the system default port mode to Fibre Channel in storage VDCs.

SUMMARY STEPS
1.

configure terminal

2.

system default switchport [shutdown]

3.

exit

4.

(Optional) show interface brief

5.

(Optional) copy running-config startup-config

DETAILED STEPS

Step 1

Command

Purpose

configure terminal

Enters configuration mode.

Example:
switch# configure terminal
switch(config)#

Step 2

system default switchport [shutdown]
Example:
switch(config-if)# system default
switchport

Step 3

exit

Sets the default port mode for all interfaces on the
system to Layer 2 access port mode. By default, all the
interfaces are Layer 3.
Exits the interface mode.

Example:
switch(config-if)# exit
switch(config)#

Step 4

show interface brief
Example:
switch# show interface brief

Step 5

copy running-config startup-config
Example:
switch(config)# copy running-config
startup-config

(Optional) Displays the status and information for
interfaces.
(Optional) Copies the running configuration to the
startup configuration.

This example shows how to set the system ports to be Layer 2 access ports by default:
switch# configure terminal
switch(config-if)# system default switchport
switch(config-if)#
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Verifying the Interface Configuration
To display access and trunk interface configuration information, perform one of the following tasks:
Command

Purpose

show interface ethernet slot/port [brief | |
Displays the interface configuration
counters | debounce | description | flowcontrol |
mac-address | status | transceiver]
show interface brief

Displays interface configuration information,
including the mode.

show interface switchport

Displays information, including access and trunk
interface, information for all Layer 2 interfaces.

show interface trunk [module module-number | Displays trunk configuration information.
vlan vlan-id]
show interface capabilities

Displays information on the capabilities of the
interfaces.

show running-config interface ethernet
slot/port

Displays configuration information about the
specified interface.

show running-config interface port-channel
slot/port

Displays configuration information about the
specified port-channel interface.

For detailed information about these commands, see the Cisco Nexus 7000 Series NX-OS Layer 2
Switching Command Reference.

Monitoring the Layer 2 Interfaces
Use the following commands to display layer 2 interfaces:
Command

Purpose

clear counters [interface]

Clears the counters.

load- interval {interval seconds {1 | 2 | 3}}

Beginning with Cisco NX-OS Release 4.2(1) for
the Cisco Nexus 7000 Series devices, sets three
different sampling intervals to bit-rate and
packet-rate statistics.

show interface counters [module module]

Displays input and output octets unicast packets,
multicast packets, and broadcast packets.

show interface counters detailed [all]

Displays input packets, bytes, and multicast as
well as output packets and bytes.

show interface counters errors [module
module]

Displays information on the number of error
packets.

See the Cisco Nexus 7000 Series NX-OS Interfaces Command Reference, for information on these
commands.
To display statistical information, you can create the following charts, which appear in the Statistics tab:
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•

Traffic Statistics Chart—Displays information about ports, including unicast, multicast, discards,
and so forth.

•

Error Counters Chart—Displays errors about the access or trunk interface, including alignments,
collisions, runts, giants, and so forth.

•

SFP Diagnostic Chart—Displays diagnostic information about the SFP transceivers that are
connected to this device.

•

Trunk Statistics Chart—Displays information about the trunk when you select a trunk port,
including unicast, multicast, and so forth.

•

SOLM Statistics Chart—Displays data about the received and transmitted traffic for unicast and
multicast.

Note

•

The SOLM Statistics Chart is applicable only for the Cisco Nexus 4000 platform, beginning
with the Cisco DCNM 4.2(3) release.

FIP Statistics Chart – Displays FIP statistics for the selected Ethernet interface.

See the “Working with Statistics and Charts” section in the Fundamentals Configuration Guide, Cisco
DCNM for LAN, Release 5.x , for more information on collecting statistics for this feature.

Example Configurations for Access and Trunk Ports
The following example shows how to configure a Layer 2 access interface and assign the access VLAN
mode for that interface:
switch# configure terminal
switch(config)# interface ethernet 2/30
switch(config-if)# switchport
switch(config-if)# switchport mode access
switch(config-if)# switchport access vlan 5
switch(config-if)#

The following example shows how to configure a Layer 2 trunk interface, assign the native VLAN and
the allowed VLANs, and configure the device to tag the native VLAN traffic on the trunk interface:
switch# configure terminal
switch(config)# interface ethernet 2/35
switch(config-if)# switchport
switch(config-if)# switchport mode trunk
switch(config-if)# switchport trunk native vlan 10
switch(config-if)# switchport trunk allowed vlan 5, 10
switch(config-if)# exit
switch(config)# vlan dot1q tag native
switch(config)#

Field Descriptions
The field descriptions for the fields discussed in this chapter are in Chapter 2, “Configuring Basic
Interface Parameters.”
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Additional References
For additional information related to implementing access and trunk port modes, see the following
sections:
•

Related Documents, page 3-139

•

Standards, page 3-139

•

MIBs, page 3-140

Related Documents
Related Topic

Document Title

Configuring Layer 3 interfaces

Chapter 4, “Configuring Layer 3 Interfaces”

Port channels

Chapter 5, “Configuring Port Channels”

VLANs, private VLANs, and STP

Cisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration
Guide, Release 5.x

VLANs, private VLANs, STP

Layer 2 Switching Configuration Guide, Cisco DCNM for LAN,
Release 6.x

Command reference

Cisco Nexus 7000 Series NX-OS Interfaces Command Reference

Interfaces

Interfaces Configuration Guide, Cisco DCNM for LAN, Release 6.x

Interfaces

Cisco Nexus 7000 Series NX-OS Interfaces Configuration Guide,
Release 5.x

System management

Cisco Nexus 7000 Series NX-OS System Management Configuration
Guide, Release 5.x

High availability

Cisco Nexus 7000 Series NX-OS High Availability and Redundancy
Guide, Release 5.x

VDCs

Cisco Nexus 7000 Series NX-OS Virtual Device Context
Configuration Guide, Release 5.x

VDCs

Virtual Device Context Configuration Guide, Cisco DCNM for LAN,
Release 6.x

Licensing

Cisco NX-OS Licensing Guide

Licensing

Cisco DCNM Installation and Licensing Guide, Release 5.x

Release Notes

Cisco Nexus 7000 Series NX-OS Release Notes, Release 5.x

Release Notes

Cisco DCNM Release Notes, Release 7.x

Standards
Standards

Title

No new or modified standards are supported by this
—
feature, and support for existing standards has not been
modified by this feature.
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MIBs
MIBs

MIBs Link

•

BRIDGE-MIB

To locate and download MIBs, go to the following URL:

•

IF-MIB

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

•

CISCO-IF-EXTENSION-MIB

•

ETHERLIKE-MIB

Feature History for Configuring Layer 2 Interfaces
Table 3-2 lists the release history for this feature.
Table 3-2

Feature History for Configuring Layer 2 Interfaces

Feature Name

Releases

Feature Information

Layer 2 interfaces

4.0(1)

This feature was introduced.

SFP Diagnostic and SOLM Statical charts

4.2(3)

This feature was introduced.

Three configurable sampling intervals for
interface statistics

4.2(1)

Added the load-interval command.

Default interfaces

5.2(1)

Added the default interface command to clear
configuration of multiple interfaces.

SVI autostate exclude

5.2(1)

Added the switchport autostate exclude command to
prevent a port’s state from affecting the up or down state of
the SVI.
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